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Chapter 714 

One-Sample Logrank 
Tests 
Introduction 
This module computes the sample size and power of the one-sample logrank test which is used to compare the 
survival curve of a single treatment group to that of a historic control. Such is often the case in clinical phase-II 
trials with survival endpoints. Accrual time, follow-up time, and hazard rates are parameters that can be set.  

Several authors have presented sample size formulas for this situation. We have adopted those of Wu (2015) 
because his paper included an extensive simulation study that showed that his formulation is the most accurate. 

Technical Details 

One-Sample Logrank Test Statistic 
The following details follow closely the results in Wu (2015). 

Suppose N subjects are enrolled in a study during the accrual period of length ta and then observed during a 
follow-up period of length tf. Let ti and Ci denote the failure time and censoring time of the ith subject. The 
observed failure time is Xi = ti ^ Ci and the observed failure indicator is Δi = I(ti ≤ Ci). The one-sample logrank test 
L is defined in terms of the number of observed events O and the number of expected events E, as follows. 

𝐿𝐿 =
𝑂𝑂 − 𝐸𝐸
√𝐸𝐸

 

where 

𝑂𝑂 = �∆𝑖𝑖

𝑁𝑁

𝑖𝑖=1

 

𝐸𝐸 = �Λ0(𝑋𝑋𝑖𝑖)
𝑁𝑁

𝑖𝑖=1

 

 

Here Λ0(𝑋𝑋𝑖𝑖) represents the cumulative hazard function Λ0(𝑡𝑡) under the null hypothesis evaluated at Xi. The test 
statistic L is asymptotically distributed as the standard normal distribution under the null hypothesis. 

The cumulative survival function is taken to be the Weibull distribution because of the many different shapes that 
it can take depending on its shape parameter. 
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Power Calculation 
Wu (2015) gives the following power and sample size formulas for a one-sided hypothesis test based on L. Note 
that we use the subscript 0 to represent the historic control and the subscript 1 to represent the new treatment 
group. 

𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃 ≅ Φ�−
𝜎𝜎0
𝜎𝜎
𝑧𝑧1−𝛼𝛼 −

𝜔𝜔√𝑛𝑛
𝜎𝜎 � 

𝑛𝑛 =
(𝜎𝜎0𝑧𝑧1−𝛼𝛼 + 𝜎𝜎𝑧𝑧𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃)2

𝜔𝜔2  

where 

𝜔𝜔 = 𝜎𝜎1
2 − 𝜎𝜎0

2 

𝜎𝜎2 = 𝑝𝑝1 − 𝑝𝑝12 + 2𝑝𝑝00 − 𝑝𝑝02 − 2𝑝𝑝01 + 2𝑝𝑝0𝑝𝑝1 

𝜎𝜎02 = 𝑝𝑝0 

𝜎𝜎12 = 𝑝𝑝1 

𝑝𝑝0 = � 𝐺𝐺(𝑡𝑡)𝑆𝑆1(𝑡𝑡)λ0(𝑡𝑡)𝑑𝑑𝑑𝑑
∞

0
 

𝑝𝑝1 = � 𝐺𝐺(𝑡𝑡)𝑆𝑆1(𝑡𝑡)λ1(𝑡𝑡)𝑑𝑑𝑑𝑑
∞

0
 

𝑝𝑝00 = � 𝐺𝐺(𝑡𝑡)𝑆𝑆1(𝑡𝑡)Λ0(𝑡𝑡)λ0(𝑡𝑡)𝑑𝑑𝑑𝑑
∞

0
 

𝑝𝑝01 = � 𝐺𝐺(𝑡𝑡)𝑆𝑆1(𝑡𝑡)Λ0(𝑡𝑡)λ1(𝑡𝑡)𝑑𝑑𝑑𝑑
∞

0
 

Note that p1 gives the probability that a subject experiences a failure during the study.  

Assuming a uniform accrual, the censoring distribution function G(t) is given by 

𝐺𝐺(𝑡𝑡) =

⎩
⎪
⎨

⎪
⎧ 1 if 𝑡𝑡 ≤ 𝑡𝑡𝑓𝑓
𝑡𝑡𝑎𝑎 + 𝑡𝑡𝑓𝑓 − 𝑡𝑡

𝑡𝑡𝑎𝑎
if 𝑡𝑡𝑓𝑓 ≤ 𝑡𝑡 ≤ 𝑡𝑡𝑎𝑎 + 𝑡𝑡𝑓𝑓

0 otherwise

 

Note that ta represents the accrual time and tf represents the follow-up time. 

Assuming that failure times follow a two-parameter Weibull distribution, the cumulative survival function S(t) 
under null and alternative is given by 

𝑆𝑆0(𝑡𝑡) = 𝑒𝑒𝑒𝑒𝑒𝑒�−𝜆𝜆0𝑡𝑡𝑘𝑘� 

𝑆𝑆1(𝑡𝑡) = 𝑒𝑒𝑒𝑒𝑒𝑒�−𝜆𝜆1𝑡𝑡𝑘𝑘� 

The hazard and cumulative hazard functions are given as  

𝜆𝜆0(𝑡𝑡) = 𝑘𝑘𝜆𝜆0𝑡𝑡𝑘𝑘−1 

𝜆𝜆1(𝑡𝑡) = 𝑘𝑘𝜆𝜆1𝑡𝑡𝑘𝑘−1 

Λ0(𝑡𝑡) = 𝜆𝜆0𝑡𝑡𝑘𝑘 

The values of the p0, p1, p00, and p01 can be calculated by numeric integration. 
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The hazard rates λ0 and λ1 can be given in terms of the hazard ratio HR, the median survival times M0 and M1, or 
the survival proportions S0 and S1 at time t0. These parameters are defined as 

𝐻𝐻𝐻𝐻 = 𝜆𝜆1/𝜆𝜆0 

𝜆𝜆0 =
log 2
𝑀𝑀0
𝑘𝑘 =

− log𝑆𝑆0(𝑡𝑡0)
𝑡𝑡0𝑘𝑘

 

𝜆𝜆1 =
log 2
𝑀𝑀1
𝑘𝑘 =

− log𝑆𝑆1(𝑡𝑡0)
𝑡𝑡0𝑘𝑘

 

Procedure Options 
This section describes the options that are specific to this procedure. These are located on the Design tab. For 
more information about the options of other tabs, go to the Procedure Window chapter. 

Design Tab 
The Design tab contains most of the parameters and options that you will be concerned with. This chapter covers 
four procedures, each of which has different effect size options. However, many of the options are common to all 
four procedures. These common options will be displayed first, followed by the various effect size options. 

Solve For 

Solve For 
This option specifies the parameter to be solved for from the other parameters. The parameters that may be 
selected are Power, Sample Size, and Effect Size. Note that the Effect Size depends on the parameterization that is 
chosen. 

Select Sample Size when you want to calculate the sample size needed to achieve a given power and alpha level.  

Select Power when you want to calculate the power.  

Test 

Alternative Hypothesis 
Specify whether the statistical test is two-sided or one-sided.  

• Two-Sided 
This option tests whether the two hazards rates, median survival times, or survival proportions are different 
(Ha: λ1 ≠ λ0). This option causes α/2 to be substituted for α in the calculations. 

• One-Sided 
When this option is used and the value of λ1 is less than λ0, rejecting the null hypothesis results in the 
conclusion that the new group’s hazard rate (λ1) is less than the historic control hazard rate (λ0). Otherwise, 
the opposite conclusion is reached.  

When you use a one-sided test, you should divide your alpha level by two to keep your significance level 
comparable to that of a two-sided test. 
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Power and Alpha 

Power 
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis, 
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null 
hypothesis is not rejected. In this procedure, a type-II error occurs when you fail to reject the null hypothesis of 
equal survival curves when in fact the curves are different. 

Values must be between zero and one. Historically, the value of 0.80 was used for power. For phase II trials, 0.90 
is also commonly used. 

A single value may be entered here or a range of values such as 0.8 to 0.90 by 0.05 may be entered.  

Alpha 
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when you 
reject the null hypothesis of equal survival curves when in fact the curves are equal.  

Values of alpha must be between zero and one. Historically, the value of 0.05 has been used for a two-sided test 
and 0.025 has been used for a one-sided test. You should pick a value for alpha that represents the risk of a type-I 
error you are willing to take in your experimental situation.  

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.  

Sample Size  

N (Sample Size) 
Enter a value for the sample size, N. This is the number of subjects in the study. You can enter one or more 
positive integers greater than or equal to 3. You may also enter a range such as “10 to 100 by 10” or a list of 
values separated by commas or blanks such as “20 40 60 80.” 

Ta (Accrual Time) 
Enter one or more values for the number of time periods (months, years, etc.) during which subjects are entered 
into the study. The total duration of the study is equal to the Accrual Time plus the Follow-Up Time. 

Accrual times can range from 0 to on up. Enter “0” when all subjects begin the study together. 

Tf (Follow-Up Time) 
The length of time between the entry of the last individual and the end of the study. 

Effect Size 

Input Type 
Specify which set of parameters you want to use to specify the hazard rates of the historical control (λ0) and the 
new group from which the sample is drawn (λ1). These parameters are functionally related as shown above, so the 
values of λ0 and λ1 are calculated from the items you enter (if necessary). 

The possible choices are 

• Hazard Rates (λ0 and λ1) 
Enter the values of the two hazards rates (λ0 and λ1) directly. 

• Hazard Rate and Ratio (λ0 and HR) 
Enter the hazard rate of the historical control (λ0) and the hazard ratio HR = (λ1 / λ0). 
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• Median Survival Times (M0 and M1) 
Enter the median survival times of the historical control (M0) and the new group (M1). The values of λ0 and λ1 
are calculated based on the Weibull distribution as shown above. 

• Proportions Surviving (S0 and S1) 
Enter the proportions surviving for a fixed period of time (T0) of the historical control (S0) and the new group 
(S1). The values of λ0 and λ1 are calculated based on the Weibull distribution as shown above. 

λ0 (Hazard Rate – Control) 
Enter a value (or range of values) for the hazard rate (event rate or incidence rate) of the distribution of the 
historical control. This distribution is assumed to be Weibull with a known shape parameter k. 

This rate is compared to λ1 by the one-sample logrank test. The ratio of these rates, HR = λ1 / λ0, is the amount that 
this design can detect. 

The value must be greater than zero.  

Example of Estimating λ0 

If 200 control patients were followed for 1 year and 40 experienced the event of interest, the hazard rate would be 

λ0 = 40/(200*1) = 0.2 per patient-year. 

Similarly, if 200 patients were followed for 2 years and 40 experienced the event of interest, the hazard rate would 
be 

λ0 = 40/(200*2) = 0.1 per patient-year. 

Note that this estimate does not consider the censoring. For censored survival data, it is often estimated from a 
survival distribution fitted from historical data. For example,  

𝜆𝜆0 = −
ln 𝑆𝑆(𝑡𝑡0)
𝑡𝑡0𝑘𝑘

 

λ1 (Hazard Rate – New) 
Enter a value (or range of values) for the hazard rate (event rate or incidence rate) of the distribution of the 
response values in the new group. This distribution is assumed to be Weibull with a known shape parameter k. 

This rate is compared to λ1 by the one-sample logrank test. The ratio of these rates, HR = λ1 / λ0, is the amount that 
this design can detect. 

The value must be greater than zero.  

Example of Estimating λ1 

Once we have λ0 and HR, λ1 is obtained as follows 

𝜆𝜆1 = 𝐻𝐻𝐻𝐻(𝜆𝜆0) 

HR (Hazard Rate – New) 
Enter one or more values for HR, the hazard ratio λ1 / λ0. This value is used with λ0 to calculate a value for λ1. 

HR can be any number greater than zero and unequal to one. You may enter a single value or a range of values. 

M0 (Median Survival - Control) 
Specify a single value, or set of values, for the median survival time in the historical control group. Assuming a 
Weibull distribution with shape parameter k, the value of λ0 is calculated as given in the technical details above. 

This value must be a number greater than zero.  
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M1 (Median Survival - New) 
Specify a single value, or set of values, for the median survival time in the new (treatment) group. Assuming a 
Weibull distribution with shape parameter k, the value of λ1 is calculated as given in the technical details above. 

This value must be a number greater than zero.  

S0 (Proportion Surviving - Control) 
Enter the proportion surviving (S0) for a fixed period of time (T0) in the historical control group. The value of λ0 is 
calculated as given in the technical details above. 

Since this is a proportion, it must be a value between (but not including) zero and one. You may enter a single 
value or a range of values. 

S1 (Median Survival - New) 
Specify a single value, or set of values, for the median survival time in the new (treatment) group. Assuming a 
Weibull distribution with shape parameter k, the value of λ1 is calculated as given in the technical details above. 

This value must be a number greater than zero.  

T0 (Time of S0 and S1) 
When S0 and S1 are selected as the Input Type, this value is needed to give the amount of time that S0 and S1 are 
related to. Since this value is a time period, it must be a positive value. 

k (Weibull Shape Parameter) 
This is the (assumed to be known) value of Weibull shape parameter. Usually, you will need to estimate k from 
the historical controls. If you don’t have any information, you can set k to one which results in the exponential 
distribution. 

The parameter k must be a number greater than zero. Usually it is greater than zero and less than or equal to 5. 

Examples 

The shape of the Weibull distribution probability distribution function is quite different depending on the value of 
k. Here are some examples. Note that elapsed time is shown on the horizontal axis. 
 
k = 0.5 
|• 
|• 
| • 
|   • 
|        •    •       • 
+---------------------- 
 
k = 1 (Exponential) 
|• 
|   • 
|      • 
|          • 
|                •     • 
+---------------------- 
 

k = 2 
|    • 
|  •   • 
| •       • 
|•            • 
|•                      • 
+---------------------- 
 
k = 5 (approx. normal) 
|         • 
|       •   • 
|      •      • 
|    •           • 
| •                       • 
+------------------------- 

  



PASS Sample Size Software NCSS.com 
One-Sample Logrank Tests 

714-7 
 © NCSS, LLC. All Rights Reserved. 

Example 1 – Finding the Sample Size  
A researcher is planning a clinical trial to compare the response of a new treatment to that of the current 
treatment. The median survival time in the current population is 1.54. The current population of responses 
exhibits a Weibull distribution with a shape parameter of 1.67. The researcher wants a sample size large enough to 
detect hazard ratios of 0.7 and 0.8 or less at a 5% significance level for a two-sided, one-sample logrank test. The 
accrual period will be 1 year. The researcher would like to compare the sample requirements if the follow-up 
period is 1, 2, or 3 years. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home 
window, load the One-Sample Logrank Tests procedure window by expanding Survival, then One Survival 
Curve, and then clicking on One-Sample Logrank Tests. You may then make the appropriate entries as listed 
below, or open Example 1 by going to the File menu and choosing Open Example Template. 

Option Value 
Design Tab 
Solve For ................................................ Sample Size 
Alternative Hypothesis ............................ Two-Sided 
Power ...................................................... 0.90 
Alpha ....................................................... 0.05 
Ta (Accrual Time) ................................... 1 
Tf (Follow-Up Time) ................................ 1 2 3 
Input Type ............................................... M0, HR (Median Survival, Hazard Ratio) 
M0 (Median Survival – Control) .............. 1.54 
HR (Hazard Ratio) .................................. 0.7 0.8 
k (Weibull Shape Parameter) ................. 1.67 

Annotated Output 
Click the Calculate button to perform the calculations and generate the following output. 

Numeric Results 
 
Numeric Results for the Two-Sided, One-Sample Logrank Test 
 
                         λ1/λ0 Cntl  New  Wei-             
               Accr   FU   Haz  Med  Med  bull        Prob 
        Events Time Time Ratio Surv Surv Shape       Event 
Power N      E   Ta   Tf    HR   M0   M1     k Alpha    P1 
0.9011 208 77 1.0 1.0 0.700 1.54 1.91 1.67 0.050 0.3706 
0.9004 495 203 1.0 1.0 0.800 1.54 1.76 1.67 0.050 0.4098 
0.9017 125 82 1.0 2.0 0.700 1.54 1.91 1.67 0.050 0.6591 
0.9007 300 212 1.0 2.0 0.800 1.54 1.76 1.67 0.050 0.7066 
0.9014 103 87 1.0 3.0 0.700 1.54 1.91 1.67 0.050 0.8481 
0.9003 249 220 1.0 3.0 0.800 1.54 1.76 1.67 0.050 0.8833 
 
References 
Wu, Jianrong. 2015. 'Sample size calculation for the one-sample log-rank test', Pharmaceutical Statistics, 
   Volume 14, pages 26-33. 
Wu, Jianrong. 2014. 'A New One-Sample Log-Rank Test', J Biomet Biostat 5; 210. 
Finkelstein D, Muzikansky A, Schoenfeld D. 2003. 'Comparing Survival of a Sample to That of a Standard 
   Population', Journal of the National Cancer Institute, 95, pages 1434-1439. 
Sun X, Peng P, Tu D. 2011. 'Phase II cancer clinical trials with a one-sample log-rank test and its 
   corrections based on the Edgeworth expansion', Contemporary Clinical Trials, 32, pages 108-113. 
Schmidt R., Kwiecien R, Faldum A, Berthold F, Hero B, Ligges S. 2015. 'Sample size calculation for the 
   one-sample log-rank test', Stat Med, 34(6), pages 1031-40. 
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Report Definitions 
Power is the probability of rejecting a false null hypothesis. 
N is the sample size of the New group, assuming no subject lost to dropout or follow-up during the study. 
E is the expected number of events (failures) in the new group during the study. 
Ta is the length of the accrual time during which subjects are added to the study. Subjects are added 
   uniformly. 
Tf is the length of the follow-up time after the last subject is added to the study. 
HR is the hazard ratio (λ1/λ0) is the new group's hazard rate divided by the hazard rate of the historic 
   control. 
M0 is the median survival time of the historic control group. 
M1 is the median survival time of the new (treatment) group. 
k is the shape parameter of the Weibull distribution used for both groups. 
Alpha is the probability of rejecting a true null hypothesis. 
P1 is the probability that a subject in the new group experiences an event (failure) during the study. 
 
Summary Statements 
A two-sided, one-sample logrank test calculated from a sample of 208 subjects achieves 90.1% 
power at a 0.050 significance level to detect a hazard ratio of 0.700 when the median survival 
time of the historic control group is 1.54. Subjects are accrued for a period of 1.0. Follow-up 
continues for a period of 1.0 after the last subject is added. The probability that a subject 
experiences an event during the study is 0.3706. The expected number of events during the study 
is 77. It is assumed that the survival time distributions of both groups are approximated 
reasonable well by the Weibull distribution with a shape parameter of 1.67. 
 

This report presents the calculated sample sizes for each scenario as well as the values of the other parameters. 

Plots Section 
 

      
   

This plot shows the relationship between sample size, follow-up time, and HR.  
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Example 2 – Validation using Wu (2015) 
Wu (2015) gives an example in which the power if 0.80, alpha = 0.05 for a one-sided test, k = 1.22, Ta = 5 and Tf 
= 3, HR = 0.57143, and M0 = 9. Wu calculates N to be 88. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home 
window, load the One-Sample Logrank Tests procedure window by expanding Survival, then One Survival 
Curve, and then clicking on One-Sample Logrank Tests. You may then make the appropriate entries as listed 
below, or open Example 2 by going to the File menu and choosing Open Example Template. 

Option Value 
Design Tab 
Solve For ................................................ Sample Size 
Alternative Hypothesis ............................ One-Sided 
Power ...................................................... 0.80 
Alpha ....................................................... 0.05 
Ta (Accrual Time) ................................... 5 
Tf (Follow-Up Time) ................................ 3 
Input Type ............................................... M0, HR (Median Survival, Hazard Ratio) 
M0 (Median Survival – Control) .............. 9 
HR (Hazard Ratio) .................................. 0.5714 
k (Weibull Shape Parameter) ................. 1.22 

Output 
Click the Calculate button to perform the calculations and generate the following output. 

Numeric Results 
 
Numeric Results for the Two-Sided, One-Sample Logrank Test 
 
                         λ1/λ0 Cntl  New  Wei-             
               Accr   FU   Haz  Med  Med  bull        Prob 
        Events Time Time Ratio Surv Surv Shape       Event 
Power N      E   Ta   Tf    HR   M0   M1     k Alpha    P1 
0.8032 88 17 5.0 3.0 0.571 9.00 14.24 1.22 0.050 0.1949 
 

PASS has also calculated N as 88. 
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